Volcanism in Eastern Africa

Final Report
NASA/ASEE Summer Faculty Fellowship Program - 1995
Johnson Space Center

Prepared By: Clay Cauthen and Cassandra R. Coombs, Ph.D.
Academic Rank: Student
University & Department: College of Charleston Department of Geology Charleston, S.C. 29424

NASA/JSC
Directorate: Space and Life Sciences
Division: Solar System Exploration
JSC Colleague: David McKay, Ph.D.
Date Submitted: August 3, 1995
Contract Number: NGT-44-001-800
Abstract

In 1891, the Virunga Mountains of Eastern Zaire were first acknowledged as volcanoes, and since then, the Virunga Mountain chain has demonstrated its potentially violent volcanic nature. The Virunga Mountains lie across the Eastern African Rift in an E-W direction located north of Lake Kivu. Mt. Nyamuragira and Mt. Nyiragongo present the most hazard of the eight mountains making up Virunga volcanic field, with the most recent activity during the 1970-90's.

In 1977, after almost eighty years of moderate activity and periods of quiescence, Mt. Nyamuragira became highly active with lava flows that extruded from fissures on flanks circumscribing the volcano. The flows destroyed vast areas of vegetation and Zairian National Park areas, but no casualties were reported. Mt. Nyiragongo exhibited the same type volcanic activity, in association with regional tectonics that effected Mt. Nyamuragira, with variations of lava lake levels, lava fountains, and lava flows that resided in Lake Kivu. Mt. Nyiragongo, recently named a Decade volcano, presents both a direct and an indirect hazard to the inhabitants and properties located near the volcano. The Virunga volcanoes pose four major threats: volcanic eruptions, lava flows, toxic gas emission (CH4 and CO2), and earthquakes. Thus, the volcanoes of the Eastern African volcanic field emanate harm to the surrounding area by the forecast of volcanic eruptions.

During the JSC Summer Fellowship program, we will acquire and collate remote sensing, photographic (Space Shuttle images), topographic and field data. In addition, maps of the extent and morphology(ies) of the features will be constructed using digital image information. The database generated will serve to create a Geographic Information System for easy access of information of the Eastern African volcanic field. The analysis of volcanism in Eastern Africa will permit a comparison for those areas from which we have field data.

Results from this summer's work will permit further study and monitoring of the volcanic activity in the area. This is of concern due to the large numbers of refugees fleeing into Zaire where they are being positioned at the base of Mt. Nyiragongo. The refugees located at the base of the volcano are in direct hazard of suffocation by gas emission and destruction by lava flow. The results from this summer study will be used to secure future funding to enable continuation of this project.
VOLCANISM IN EASTERN AFRICA

Introduction

Background
The African rift system extends 2200km down the continent of Africa from the coastal region of Ethiopia (Red Sea) to fault regions of Tanzania. The rift system is unique, for it is believed to be connected to the global mid-oceanic ridge system (Heezen and Ewing, 1963). The spectacular African rift system is divided into an eastern and a western portion. The Eastern African rift and/or the hotspots are responsible for the contents volcanoes in this area. This paper will focus on the eastern portion of the rift system, specifically regions in Zaire where Mt. Nyiragongo and Mt. Nyamuragira of the Virunga Mountains reside. (Baker et al., 1970)

In 1891, the Virunga Mountains of Eastern Zaire were first acknowledged as volcanoes, and since then, the Virunga Mountain chain has demonstrated its potentially violent volcanic nature. The Virunga Mountains lie across the Eastern African Rift in an E-W direction located north of Lake Kivu. Mt. Nyamuragira and Mt. Nyiragongo present the most hazard of the eight mountains making up Virunga volcanic field, with the most recent activity in 1982 at Nyiragongo and 1991 at Nyamuragira. (Tazieff, 1994)

In 1977, after almost eighty years of moderate activity and periods of quiescence, Mt. Nyamuragira became highly active with lava flows that extruded from fissures on flanks circumscribing the volcano. The flows destroyed vast areas of vegetation and Zairian National Park areas, but no casualties were reported. Mt. Nyiragongo exhibited the same type volcanic activity, in association with regional tectonics that effected Mt. Nyamuragira, with variations of lava lake levels, lava fountains, and lava flows that resided in Lake Kivu. Mt. Nyiragongo, recently named a Decade volcano (1991), presents both a direct and an indirect hazard to the inhabitants and properties located near the volcano. The Virunga volcanoes pose four major threats: volcanic eruptions, lava flows, toxic gas emission (CH4 and CO2), and earthquakes. Thus, the volcanoes of the Eastern African volcanic field emanate harm to the surrounding area by the forecast of volcanic eruptions.

Purpose
As an outcome of preliminary stages of this project, we will acquire and collate remote sensing, photographic (Space Shuttle images), topographic and field data. In addition, maps of the extent and morphology(ies) of the features will be constructed using digital image information. The database generated will serve to create a Geographic Information System for easy access of information of the Eastern African volcanic field. The analysis of volcanism in Eastern Africa will permit a comparison for those areas from which we have field data.

Results from this preliminary work will permit further study and monitoring of the volcanic activity in the area. This is of concern due to the large numbers of refugees fleeing into Zaire where they are being positioned at the base of Mt. Nyiragongo. The refugees located at the base of the volcano are in direct hazard of suffocation by gas emission and destruction by lava flow. The results from this summer study will be used to secure future funding to enable continuation of this project.

Also, another aspect of this study is to clear up any discrepancies that I and many others have come across when studying these volcanoes. Thus,
throughout the paper, the reader will note times where I clarify or allude to another source with as slightly different results or data. I am not disregarding their validity, though, but rather formatting their data with a collective schematics.

Geographic Information Systems
Geographic Information Systems are means of efficient, quick access to information concerning a specific area. The GIS is a computer system capable of capturing, analyzing and displaying 2D, 3D, or 4D information. The GIS database allows quick reference to areas of concern. This facilitates monitoring and further studies of the given areas. The assessment of Nyamuragira and Nyiragongo volcanoes using the GIS will include regional geography (rivers, hills, etc.), volcanic complexes, cinder and scoria cones, villages, refugee camps, cities, roads, geophysics (faults and fractures), seismic stations (i.e. instrumentation sites), areas of immediate concern (of Mazuku hazard, lava flow hazard, and mud slides), rainfall, drainage, and foliage patterns. See Appendix A at the end for the detailed steps of compiling the GIS. The figure below graphical displays the format of the GIS.

Figure 1. Courtesy of Cassandra Coombs

Nyiragongo

I. Introduction
II. Geography
III. Form and Structure
IV. Volcanic Activity
V. Petrography

I. Introduction
Mt. Nyiragongo lies at the southern region of the Western rift branch of the Eastern African rift system in the Virunga province. The volcano has been recorded as active since 1884 and more less, has been active up to the present, only with a brief period of quiescence of 1930-1935. Mt. Nyiragongo is a stratovolcano, and off and on throughout the recorded history of the volcano has had steady-state lava lake at the summit of the volcano. In January of 1977, Mt. Nyiragongo became highly active with the drainage of the lava lake at the summit and basaltic lava flows erupting from fissures semi-circumscribing the volcano. The eruption destroyed acres of land and took over 100 lives. Mt. Nyiragongo is one of the few volcanoes in recorded time that has taken so many lives. In 1982, the volcano reactivated consisting of lava fountains and continual feeding of the lava lake. The Nyiragongo volcano has been characterized with explosive behavior and extreme fluidity of the lava. Since 1990, Mt. Nyiragongo has been named a Decade Volcano by the International Association of Volcanology and Chemistry of the Earth's Interior (IAVCEI), but research concerning the volcano is constantly delayed because of the political unrest in Zaire.

II. Geography

Mt. Nyiragongo (29°15' E, 1°30' S) is located 20km north of Lake Kivu and Goma, Zaire. It is also one of the eight volcanoes in the Virunga volcanic province that lies along the Western branch of the African Rift system. Mt. Nyiragongo's summit crater is 3465m above sea level and 2010m above Lake Kivu. Nyiragongo is south-east of it's more massive volcanic brother, Mt. Nyamuragira. Around the flanks of the volcano, fissures and scoria cones lie that are in a north western trend that highlight the evidence of the African Rift system. The major scoria cones (parasite vents) are Baruta (north flank), Shaheru (south flank), and Rashayo (south-west flank). These parasite vents attribute to a moderate amount of Nyiragongo's activity (this will be explain in detail later). Mt. Nyiragongo has an external gradient of 40° on the southern flank and 55° to 60° on the eastern and western flanks.

At the summit of the volcano, a caldera of 1km in diameter sits. The caldera sinks 200m into the volcano with the slope gradient of the inner rim of 60° to 80°. At the base of the crater of the caldera, 500m wide, lies the permanent lava lake that has varied in volume and size over its recorded history of 1928.

III. Form and Structure

Mt. Nyiragongo is the result of tectonic activities of the western branch of the Eastern African rift system. The volcano has a general morphology of a stratovolcano which is evident by a central effusive pipe and radial eruptions. The Nyiragongo complex is composed of three overlapping volcanoes: (from north to south) Baruta, Nyiragongo, and Shaheru. All three have a pit crater at their respective summit. Nyiragongo is the youngest and the main cone of the volcanic complex. Over decades of activity, Shaheru has been, for the most part, obliterated by flows from the southern flank of Nyiragongo, while Baruta has remained well preserved and relatively undisturbed by Nyiragongo's flows. (Demant et al. 1994)

At the summit of the volcano, the pit crater (or caldera) is 1km in diameter and sinks 200 meters into the volcano. The pit crater dominated by lava lake, fluctuating in volume over the years with respect to its activeness.
The crater has been differentiated into three units: an upper, intermediate, and lower.

The Upper Unit (UU) is about 20m thick, composed of a succession of "thin decimetric to metric flows with scoriaceous basis" (Demant et al., 1994). The UU-lavas have an abundance of nepheline crystals, and observations denote that there is a series of progressions with little change between the lavas on the upper-most part of the crater wall and on the flanks. The observations reflect the periodic over flowing of the rim by the lava lake.

The Intermediate Unit (IU) is 50m thick composed of flows that are generally 1 meter thick, and dominated by leucite and nepheline megacrysts--usually forming aggregates. The flows indicate periodic over flowing "of a molten lava column from an open crater" (Demant et al., 1994). There are numerous vertical dikes on the crater wall which represents a relationship of the Lower Unit and the Intermediate Unit. Thus, Demant et al. reveal by the relationship of the IU and the LU that the collapse of the pit crater occurred towards the end of the Intermediate Unit.

The Lower Unit (LU) is dominated by 90 meters of pyroclastic deposits. In "Volcanological and petrological evolution of the Nyiragongo volcano, Virunga volcanic field, Zaire", Demant et al. offers a successional description of the LU starting from the bottom of the Lower Unit to the top:

1. Above the upper platform (157m from the rim of the crater), there is a thick layer of "chaotic" pyroclastic deposition with large round chunks of lava (up to a few meters in diameter). There are two facies of course-grained lavas with melilitite phenocrysts and clino-pyroxene rich, porphyritic in texture and prominent flow bands.

2. Between -142 and -108m of the inner wall there is finely stratified and non-welded cinders. Demant et al. notes that the color and the complex stratification are characteristic of a hydromagmatic style of eruption.

3. The top 30 meters of the LU reveal a succession of ten lava flows which are the result of rhythmic explosion phases from the open crater. The alternating flows of pyroclastic materials indicate the growth stages of the volcano which is typical of a stratovolcano (explosive and effusive).

Interruptions of volcanic activity are represented by irregular contacts between the LU and the IU. The latter stages (IU and UU) are mainly effusive-type deposits and "correspond to the overflowing magma above the pit crater" (Demant et al., 1994). The UU is an artifact of these successional over-flows from the lava lake.

![Figure 2. Map of Mt. Nyiragongo showing Baruta and Shaheru. Map is courtesy of N. Zana.](image-url)

Baruta, Shaheru, and parasite cones. Baruta and Shaheru (See Figure 1) have been consider to be parasite cones, but for the classification...
schematics of this project and due to the Demant et al. 1994 research, Baruta and Shaheru are classified as long lived stratovolcanoes.

Baruta, north of the Nyiragongo caldera, has a crater 900m in diameter and is 250m deep. The Northwestern wall of the pit was destroyed during an undated eruption, producing a second crater in a NNW direction. Fracture trends of the Baruta stratovolcano are parallel to those of Nyamuragira and Nyiragongo. The lavas are composed mainly of nephelinites and melilitites which are genetically similar to those of Nyiragongo. The inner subvertical wall of the crater reveals a nice outcrop of alternating pyroclastic and massive lavas, which are dissected by a vertical dike.

Shaheru is the oldest of the Nyiragongo complex and flows from Nyiragongo have smothered the northern flanks of Shaheru. In 1977 eruption, flows from Nyiragongo partially filled the crater of Shaheru. The southern slopes of Shaheru seem to be the only uncontaminated portion of the volcano.

About 100 parasite cones surround the Nyiragongo complex. On the northeastern trend, Rashayo (a group of about 20 vents) extend 10km along the base of Nyiragongo. Hydroclastic tuffs around many of the parasitic cones reveals evidence of lacustrine eruptions. Many of the cones are a part of the complex fissure zone (elongated in shape). The cones are constantly recycled (destroyed and rebuilt) because of the high activity along the fissure zones.

IV. Volcanic Activity

Volcanologists have recorded and dated the volcanic activity of Mt. Nyiragongo from 1884 to the present. Tazieff describes the evolution of Nyiragongo and its siblings of the Virunga Mountain Chain: "Successive eruptions over the past one or two billion years have resulted in the build up of billions of cubic yards of lava; that immense volume of lava comprises the Virunga Mountain Chain" (Tazieff, 1977).

The following is a compilation of a brief history outline of Nyiragongo's activity:

Note that the name in parenthesis is the scientist, lay man, or missionary that documented the activity. In several instances, the person who cited the activity had no formal training as a volcanologist or even geology, but rather a mere spectator of the activity. Periods without a citation following usually means that a native tribe has dated the activity, and I could not find any names to associate with it. Also, I tried to be as specific as I could with regard to the research that I have done.

<table>
<thead>
<tr>
<th>Year</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1884</td>
<td>a normal explosion from the central crater of the southern portion of the pit (Linke)</td>
</tr>
<tr>
<td>1891</td>
<td>a central crater eruption and lava lake activity. Von Gotzen noted on his expedition to the summit of the crater that same year: &quot;The volcano shines in the night like a column of fire&quot; (Tazieff, 1976).</td>
</tr>
<tr>
<td>1898</td>
<td>a central crater eruption (Grogan)</td>
</tr>
<tr>
<td>1899</td>
<td>a central crater eruption (Moore)</td>
</tr>
<tr>
<td>1900</td>
<td>a central crater eruption (Sapper)</td>
</tr>
<tr>
<td>1901</td>
<td>a normal eruption of the central crater (Shwartz)</td>
</tr>
<tr>
<td>1902</td>
<td>a central crater eruption (Missionaries Herman and Kandt)</td>
</tr>
<tr>
<td>1905</td>
<td>a central crater eruption and lava lake activity</td>
</tr>
<tr>
<td>1906</td>
<td>a central crater eruption (Wollaston)</td>
</tr>
</tbody>
</table>
1908 ? activity on the southern portion of the central crater
August-October, 1911 a central crater eruption of the southern pit (Kirschstein and Meyer)
1918 a central crater eruption and lava lake activity
1920-1921 a normal explosion of the central crater
March-April, 1927 a central crater eruption, lava flows, and lava lake activity (Times and Barnes)
1928 a central crater eruption and dense clouds of smoke were emitted from the summit
1930-1935 the volcano had a brief period of dormancy
1935-1977 low to little activity except for variations of the lava lake level (I found little to no documentation concerning this forty-two year time period)
1977 an explosive central crater eruption, activity of regional fissures, lava lake activity, fatalities and damages
1982 a phreatic central crater eruption, lava flows, and lava lake activity
June 23, 1994 a series of small eruptions within the central crater.

Table courtesy of Catalogue of Active Volcanoes

The following section is a more in depth look at the most recent volcanic activity, specifically the eruptions of 1977, 1982, and 1994.

The 1977 eruption was a simultaneous eruption with Mt. Nyamuragira. It is the shortest volcanic eruptive episode ever recorded. The, until then, semi-permanent lava lake drained more than 20x10^6 cubic meters and spread over 20km^2 in less than one hour. Lava flows exceeded 2km^2 on the north and west flanks, while the main flows ran down the southern flank extending 10 km from their respective openings, covering an area of 18km^2. The northern and western flows ran into jungle area, and the southern and eastern flows ran into populated areas. Several villages were wiped out and an estimated 30 to 300 hundred people were burned alive by the lava flows. The main road linking southern and northern Kivu province was cut off for about 10km. In the forest lava flows damaged an area of about 3-5 million m^2. The average thickness of the lava flow was a meter or less, except for flows that extended toward the Goma air field and the temperature of the fresh lava was 1100+-30°C (Bonnet). The flows were mainly high velocity melenites.

Tazieff, using an accepted value of 1m in thickness, calculated the volume of the flow to be 20-22 million m^3, which matches the estimated volume of the lava lake and the feeding pipe. Tazieff concluded that the lava lake and feeding pipe was drained by a set of vertical fissures that opened on the northern (2,200m in altitude), western (2400m in altitude), and on the southern side (2700m in altitude) of the Nyiragongo complex. The fissures drained the lake complex in less than one and a half hours (note: that was the time extent of the whole volcanic episode). The up-down motion of the lava lake over time has caused the inner walls of the volcano to weaken and the fact that the lava lake had disappeared heightened the chance of an outbreak along the base of Nyiragongo; both of which allowed an episode of that sorts to occur. Ten days after the eruption, the lava lake was 800 meters deep and the platform(s) had disappeared which reveals the collapsing nature of the volcano.
On June 21, 1982, fresh lava began to flow into the 800 meter deep crater of the 1977 eruption, producing a molten pond at the base of the crater and a spatter cone seemingly near the bottom of the crater. On July 11, the spatter cone had vanished because of the rising lava lake, but fountains remained in the same position and magnitude. By August 4, the lava lake was entirely crusted over except for two fountains which corresponded to the initial vents (spatter cones). The surface of the lava lake was 3050m a.s.l, 370,00m² in area, and had an estimated volume of 44x10⁶. For a week or two the activity of the lava lake had seem to have stopped. On October 3, the level rose to 440m of the rim of the crater and was approximately 500m across in diameter, and the fountaining had resumed. In late October, the outflows continued but were of degassed, short-lived, and cooler (960±30 °C) lavas near the main outer portion of the lake. At this point the lava lake is at a steady-state where the volume of the lake is hypothetically not varying because the cooler magma on top will be degassed, therefore the heavier, and will sink to the bottom which allows fresh magma to rise. "The persistence of such an extraordinary large steady-state lava lake may be due to the equally exceptional fluidity of the magma rising at the intersection of four different tectonic trends of fractures in the subvolcanic basement" (Tazieff, 1982).

The most recent eruption of Nyiragongo occurred on June 23, 1994 with a small series of eruptions within the crater. Over a five month period there was an accumulation of a 500m deep lava lake that is now almost half filled. Lockwood and Casadevall recorded eruptive episode on June 23-27, August 10-13, August 25-28, and September 5-8. Their observations suggest a recycling of molten lava as noted by Tazieff in 1982 and 1977. Casadevall and Lockwood believe that Nyiragongo's present activity reveals that the volcano may be returning to the steady-state status observed before the 1977 eruption.

V. Petrography

The lavas of Nyiragongo are strongly silica-undersaturated feldspar-free lavas. The mineralogy of the walls of the pit crater have been differentiated into three units. The data table is supplied by Demant et al.

<table>
<thead>
<tr>
<th>Table 2</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Upper Unit</strong></td>
</tr>
<tr>
<td>Phenocrysts</td>
</tr>
<tr>
<td>Matrix</td>
</tr>
<tr>
<td>Accessory Phase Aggregates</td>
</tr>
<tr>
<td><strong>Intermediate Unit</strong></td>
</tr>
<tr>
<td>Phenocrysts</td>
</tr>
<tr>
<td>Matrix</td>
</tr>
<tr>
<td>Accessory Aggregates</td>
</tr>
<tr>
<td><strong>Upper Lower Unit</strong></td>
</tr>
<tr>
<td>Phenocrysts</td>
</tr>
<tr>
<td>Matrix</td>
</tr>
<tr>
<td>Aggregates</td>
</tr>
<tr>
<td><strong>Lower Lower Unit</strong></td>
</tr>
<tr>
<td>Phenocrysts</td>
</tr>
<tr>
<td>Matrix</td>
</tr>
</tbody>
</table>

S-1-9
Phenocrysts | melilitite, nepheline and kalsilite, scarce clinopyroxene, and olivine
Matrix | fine-grained; nepheline, nepheline, greenish poikilitic clinopyroxene, and olivine
Accessory phase | persokite and apatite
Aggregates | kalsilite + melilite + titanomagnetite

Table courtesy of Demant et al., 1994

These three units of the crater are the main building components of the volcano.

Nyamuragira

I. Introduction
II. Geography
III. Form and Structure
IV. Volcanic Activity
V. Petrography

I. Introduction
Of the two volcanoes, Mt. Nyamuragira has had the lesser amount of research and documentation on it, but the volcano has had more eruptions (22 eruptions since 1901) than Nyiragongo. Nyamuragira is a shield volcano and is the most active of the Virunga complex. Before the massive volcano emerged, the Nile river ran through the area, and Nyamuragira is now a natural dam separating the Nile and Lake Kivu, which is the offspring of the Nile river. Nyamuragira has many synonyms that are derived from natives tribes of the area, such as Nyamlagira and Namlagira.

II. Geography
Mt. Nyamuragira is located 40km north of Lake Kivu (1°25'S, 29°12'E). It rises 3056m above sea level and 1593m above Lake Kivu. The position of the volcano follows the NW-SW trend of the African rift system and is NW of Nyiragongo. The massive volcano has a basal extension on its longest axis of 60km. Along the exterior of the volcano, Nyamuragira has an external gradient of 8-10%.

The summit of the volcano is occupied by a large crater caldera system, 2km in diameter, with openings in the SW sector of the crater. The crater is terraced by platforms on the N, NE, and E that are separated into two by a point of land jutting into water.

The volcano is dotted by active parasite cones and satellite cones along the base of the volcano. Mikombe is located 15km NE of the summit caldera and extends to a height 60-70m. Mikombe is about 10km away from the road to Tongo. Satellite eruptions, such as Tshambe of 1938 and Muhuboli of 1948, commonly take place along fissure zones without the formation of a cone. Active parasite cones that circumscribe the flanks of the volcano are: Singiro (East flank), Nahimbi (SW flank), Rumoka (SW flank), Tshambene (SW flank), Gituro (SW flank), Muhuboli (SW flank), Shabubembe-Ndakaza (NNW fissure zone), Mihaga (SSE fissure zone), Murara (SSW flank), Kitsimbanyi (North flank), Gakararanga (North flank), Rugarama (SE flank), Harakindi (SSW flank), Gafuranindi (North flank), and Mikombe (NE flank). These parasite cones are responsible for the majority of flows and activity of Nyamuragira. The locality of refugee camps are positioned near Katale, Mugungu and Kituku.
III. Form and Structure

The general morphology is that of a shield volcano with fissure zones positioned in a NW trend of the shield. The most outstanding features of the volcano are the vast amount of satellite eruption zones on the flanks of the volcano and the surrounding area. Mainly, the eruptive zones attribute to the drainage of the lava lake at the summit caldera. Frequently, small cones have been observed with the effusion of large volumes of lava and/or sulfurous gases.

The lavas consist mainly of the Pleistocene age, and evidence dictates that the release of primary basalts are from the lower to upper mantle regions. Like Nyiragongo, these emission are relatively rare and indicative of mid-oceanic ridges. These conditions are accepted as being caused by a mantle plume below the subcrustal to upper mantle region of the Earth.

IV. Volcanic Activity

Over the past century, Mt. Nyamuragira has been the most active volcano of the Virunga Mountain chain with thirty eruption dating from 1882 to the present. The following abbreviate volcanic activity table displays the frequency and consistency of activity of Nyamuragira.

Table 3

<table>
<thead>
<tr>
<th>Year</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1882</td>
<td>venting of the northern flank</td>
</tr>
<tr>
<td>1894</td>
<td>normal explosive eruption of the central crater and lava flows</td>
</tr>
<tr>
<td>1896</td>
<td>normal explosive eruption from the central crater</td>
</tr>
<tr>
<td>1899</td>
<td>flank venting, radial fissures, normal explosive eruption, lava flows of the NNW fissure zones</td>
</tr>
<tr>
<td>1901</td>
<td>explosive eruption and lava flows of the East flank (Singiro)</td>
</tr>
<tr>
<td>1902</td>
<td>flank and fissure zone venting of the SSE fissure zone</td>
</tr>
<tr>
<td>1904</td>
<td>flank venting, explosive eruption, and lava flows of the SW flank (Nahimbi)</td>
</tr>
<tr>
<td>1905</td>
<td>flank venting, explosive eruption, and lava flows of the East flank (Kanamaharagi)</td>
</tr>
<tr>
<td>1906</td>
<td>explosive eruption of the central summit caldera</td>
</tr>
<tr>
<td>Year</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>1907</td>
<td>explosive eruption of the central summit caldera (there were two episodes documented that year, but no specific dates were given)</td>
</tr>
<tr>
<td>1908</td>
<td>explosive eruption of the central summit caldera</td>
</tr>
<tr>
<td>1909</td>
<td>explosive eruption of the central summit caldera, phreatic</td>
</tr>
<tr>
<td>1912</td>
<td>explosive eruption and lava flows of the central summit caldera and of the SW flank (Rumoka). Fatalities and damages</td>
</tr>
<tr>
<td>1920</td>
<td>explosive eruption of the SSW flank (Lake Kivu), radial fissures, and lava lake activity at the summit caldera.</td>
</tr>
<tr>
<td>1921</td>
<td>explosive eruption, lava flows, and lava lake activity of the central summit caldera</td>
</tr>
<tr>
<td>1938</td>
<td>explosive and phreatic eruption of the central summit caldera, venting of SE and SW flanks (Tshambene), regional fissures, lava flows, and a Tsunami.</td>
</tr>
<tr>
<td>1938-1940</td>
<td>eventual drainage of the lava lake of the central crater.</td>
</tr>
<tr>
<td>1948</td>
<td>explosive eruption of the SW flank (Gituro) and N flank (Muhuboli), flank and regional fissures, lava flows, and lava lake activity.</td>
</tr>
<tr>
<td>1951</td>
<td>explosive flank venting of the SW flank (Gituro)</td>
</tr>
<tr>
<td>1951</td>
<td>explosive eruption of the NNW fissure zone (Shabubembe-ndakaza), lava flows, and lava lake activity</td>
</tr>
<tr>
<td>1954</td>
<td>explosive venting of the SSE fissure zone (Mibage) and lava flows</td>
</tr>
<tr>
<td>1956</td>
<td>explosive eruption of the central summit caldera and NNW fissure zone, and lava flows associated with both</td>
</tr>
<tr>
<td>1957</td>
<td>eruption of the central summit caldera and SSE fissure zone with lava flows associated with both</td>
</tr>
<tr>
<td>1958</td>
<td>explosive eruption of the Northern flank (Kitsimbanyi) and NNW rift with lava flows associate with both</td>
</tr>
<tr>
<td>1967</td>
<td>explosive eruption of the Northern flank (Gakararanga) with lava flows</td>
</tr>
<tr>
<td>1971</td>
<td>explosive eruption of the WNW flank (Rugarama), lava flows, and damages</td>
</tr>
<tr>
<td>1976-1977</td>
<td>explosive eruption of the SSW flank (Murar and Harakandi), lava flows, and lava lake activity. The activities mentioned persisted until the 1977 eruption of Nyiragongo.</td>
</tr>
<tr>
<td>1980</td>
<td>explosive eruption of the Northern flank (Gasenyi), lava flows, and damages</td>
</tr>
<tr>
<td>1981</td>
<td>explosive eruption of the SE flank (Rugarambyo), lava flows, and damages</td>
</tr>
<tr>
<td>1984</td>
<td>explosive eruption of the NW flank (Kivandimwe), lava flows, and damages</td>
</tr>
<tr>
<td>1986</td>
<td>explosive eruption of the Southern flank (near Kitazungurwa), lava flows, lava lake activity, and damages</td>
</tr>
<tr>
<td>1987</td>
<td>explosive eruption of the Northern radial fissure (Gafuranindi) with lava flows</td>
</tr>
<tr>
<td>1989</td>
<td>explosive eruption of the central summit caldera, SE and Eastern flanks with lava flows</td>
</tr>
</tbody>
</table>
The most recent major eruptions of Mt. Nyamuragira were in 1977, 1982, and 1994. These eruptions were associated with activity of Mt. Nyiragongo. On December 11 1976, intense magma movement beneath the surface was recorded with a multitude of volcanic earthquakes. On December 23 of the same year, there was an eruption on the north eastern end of a fissure zone and explosive activity centered on three locations of the fissure zone which produced three new cinder cones. The following day Murara was created. On January 18 1977, Murara grew to 150 meters high and had a flow rate of 10m/min.; by the next day, it had slowed to 2-4m/min. Murara's activity resumed on the north end of Murara ten days later. In February, an eruption from a new flank 8m south west of the summit produced lava fountains scaling 150-180m high which formed a 70m spatter cone around the vent. The lava flows extended 1km to the west and 3km to the south west.

During the January of 1982, an eruption on the south east flank of Nyamuragira produced lava rates recorded at 20-24km/hr to 6km/hr. Observers noted the vigorous fountaining from the scoria cones and a large cloud of \( \text{SO}_2 \) emitted during the eruption.

The most recent activity was on July 4, 1994 which lasted until July 17. The eruption took place within the summit of volcano and on the western flank of the volcano. Lava fountains shot several hundred feet into the air from openings on the western flank, producing vast quantities of Pele's hair. A new line of cinder cones were produced on the western flank. Lava flows of the western flank extend 10km in a western fashion that eventual smothered a small lake. There were no reported human casualties, but cattle were reported to have died by ingesting volcanic ash.

**V. Petrography**

Mt. Nyamuragira, as with Nyiragongo, are chemically exceptional volcanoes. The lavas are mainly leucite basanites, leucite teraialites (Finckh, 1912), basanitiods, olivine hyalobasalts (Pullfrey and Richard, 1950), and occasionally basanitiod limburgites from the Nahimbi eruption of 1904. The lavas have a very low viscosity with \( \text{SiO}_2 \) averages of 44-45 and range from 34.72 to 57.64, and are, for the most part, highly potassic. The low viscosity indicates the source is tapped from an upper chamber (Blake and Ivy, 1986). Blake and Ivy have also noted temporal changes of lava flows with respect to time and chemical composition that trends increasingly become more mafic. Hayashi et al.'s geochemical analysis further the Blake and Ivy studies and indicate that there is a magma zonation where the upper portion of the chamber is more mafic than the lower portion of the chamber.

**Volcanic Hazard of Nyamuragira and Nyiragongo**

The volcanic hazards associated with an eruption and perpetual volcanic-related activity are of short and long-term concern. Moreover, there are four major concerns that threaten 100,000 population of Goma and over a million Rwandan refugees: Mazukus, lava flows, earthquakes, ash flows and the degassing of Lake Kivu. This section combines the hazards of both volcanoes,
but Mt. Nyamuragira poses less of a threat because of its locality in relation to populated areas.

Mazuku is the Swahilian equivalent for "evil winds"; the "evil winds" that the Swahilis refer to are the gas emissions associated with dry gas vents. Dry gas vents are vents that emit harmful gases into the atmosphere (i.e. CO$_2$). These vents are created when there is insufficient amounts of ground water to absorb the gas, thus a dry gas vent. From freshman chemistry, we learned that CO$_2$ is heavier than air; thus, a cloud of CO$_2$ will accumulate in areas that serve as a natural cup for the gas. The gas, though has the potential to migrate due to winds or other natural causes. Mazukus are silent and dangerous hazards that must be monitored. (Lockwood and Casadevall, 1994)

The lava flows associated with Mt. Nyiragongo are typified by silica-poor composition, making the lava of high fluidity. The lava flows would be of high velocity (1977 over 100Km/hr on the steeper slopes); therefore, it would allow little time for evacuation of the populated areas. Lockwood and Casadevall offer a recent analysis of the foundation of the highly populated Goma reveal "textures of very rapid emplacement, and is about 700 years old" (Lockwood and Casadevall, p.5), which highlights the potential destructive nature of the lava flow. Human causalities would be unexpected in areas around Goma because of the lava flow tendency (i.e. more gentle slope and the lower temperature of the lava). Damages and fatalities from lava flows of Mt. Nyamuragira are highly unlikely because the extremely gentle slope of the volcano, thus causing the lava to move slower and to a lesser extent.

Earthquakes will be associated with any major volcanic activity. An earthquake could be associated with one of the many faults surrounding the area or with the magma moving beneath the surface. Although I have yet to find any sufficient amount of information concerning the urbanization of the areas surrounding the area, Goma will run the highest risk of destabilization of edifices and other large structures that potentially would place people in harm's way. Also, an earthquake could cause the possible upwelling of Lake Kivu which allow vast amounts of CO$_2$ and CH$_4$ into the atmosphere.

Volcanic ash (Pele's hair) presents a potential threat, for the ash can cause human discomforts such as eye damage and has been documented to kill livestock if it is ingested. On the July, 1994 eruption, volcanic ash covered an area exceeding 30km$^2$.

Because of the positioning of Lake Kivu, Lake Kivu has acquired large quantities of CO$_2$ and CH$_4$ have been dissolved into the deep water of the lake. Currently, the lake is at steady level and degassing without a major force is unlikely, Lockwood and Casadevall note that "large subsurface landslide or lava flow into the lake" or even an earthquake could cause the fatal upwelling and the degassing of the lake.

A major eruption of Mt. Nyiragongo could be devastating because of the highly populated areas of Goma and the refugee camps. A major eruption could cause indirect hazards such as the degassing of Lake Kivu and Mazukus and the direct hazards of lava flows and earthquakes.
Appendix A

The GIS Compilation Process

The following is a detailed analysis of the steps and tools taken while compiling the GIS.

Software and Tools:
- Adobe Photoshop
- Dimple
- Shuttle image STS 005-42-1470
- Radar image downloaded from JPL
- U-MAX Scanner
- Machintosh IIfx
- Rodime Systems Hard-drive
- Machintosh Power PC

1. The first portion of my research was text research. After compiling an adequate amount of abstracts and papers concerning the Mt. Nyiragongo and Nyamuragira volcanoes and the mechanisms of volcanism, I constructed a detailed outline that included a date-line of activity and generalities of the volcanoes.

2. Soon, after I received the STS 005-42-1470 and STS 005-42-1470 images that were formatted IBM-PC's and in the tiff picture format.

3. I converted the IBM-PC tiff files to Machintosh format by ftp'ing them to a Machintosh computer.

4. Since I would be using Dimple as the mainframe for the GIS, the tiff files had to be converted into pict files. I opened the tiff file in Adobe photoshop, and chose Save As... from the File menu. I saved the tiff file as a 32-bit pict file.

5. While in Dimple, I opened the pict file shown as a Raster. I chose Color Components from the Transform file menu. This separated the picture in a Red-Green-Blue fashion. Being in the RGB, this will allow a multiband to be formed and allow the picture to be manipulated.

6. From the Image file menu, I chose New Multiband, and saved the RGB and the color components in the Multiband.

7. From there, I wanted to establish Ground Control Points (GCP). From the Image menu, I selected Image Details, and mark the box entitled
Modify Details. I change the coordinate system from pixels to Geo. This will allow the multiband to be formatted in Longitude and Latitude, as opposed to pixel, x-y coordinates.

8. From the Image file menu, I chose New GCP model. Using the cross symbol from the cursor selection box at the top left of the screen, I selected a pre-designated point that I had exact coordinates. After pinpointing the spot, I selected Add GCP. The computer, then, ask to record the point with it’s specific longitude and latitude.

9. Once I designated three (minimum amount required for a linear calculation) points, I chose the model box that from the GCP screen to calculate the coordinate system.

The following steps involve scanning specialized maps of roads, lava flows, seismic stations, seismic activity, and general maps of the area.

10. From Adobe Photoshop, I selected Aqure=> Pulg-in Scan 3.4 from the File menu. I place the image to be scanned on the scanner and selected preveiw with the mouse. After seeing the preveiw, I selected scan with the mouse.

11. I, then, chose Save as... from the file menu saving the image as a pict file. From Adobe Photoshop, I selected Aqure=> Pulg-in Scan 3.4 from the File menu. I place the image to be scanned on the scanner and selected preveiw with the mouse. After seeing the preveiw, I selected scan with the mouse. After scanning each image, I would selected Save As... from the file menu to save the image as a 32-bit pict file.

12. After opening each image in Dimple (Open as a Raster), I overlayed each image by selecting Join Images from the Image file menu. The process of joining images is such: Join two images, then join another to the joined image, and so on. Because this combined image of all of the previously scanned images appeared to be too cluttered, I joined another image complex with only a selected bunch of the images with each other, thus making two complexes of joined images.

The Classification of the maps didn't run as smoothly as we had hope; nonetheless here are the steps that I employed while trying to classify the images.

1. I opened the multiband, and then chose the RGB composite by clicking the mouse to the right of the images name. This allowed only one picture to open.
2. I chose the tracer cursor from the box on the right hand portion of the screen. I outlined a distinct area of the map, in this case Lake Kivu. I then chose collect statistics from the Image menu. After the stats has been collected, I chose edit training sets from the Image menu. I named the new training set Lake Kivu, and chose the color that I wanted the classified portion of the map to convey on the new image. I, then, classified the area by choosing the Superfied Classification from Image menu. When you are only classifying one portion of the map, it will not take long, but when you combine more than classification, it will take thirty minutes to an hour. So for each individual classification, run an initial separate classification of that one area, so that you may see the results before running a lengthy full scale classification.

3. For the two images that I classified, I couldn't classify anymore than two training sets without an extreme drop off in precision.
References


Other references: Catalogue of Active Volcanoes 1951-1958. 2,3-2 and 2,3-3